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In this how-to-guide, we build upon learnings from our �rst guide: Power BI for Beginners. 
If you�re new to Power BI, we recommend you start with this �rst guide if you haven�t done 
so already. 

We�ll continue to use sample data from the �ctitious Adventure Works bicycle company.

The guide is split into two parts: A and B. In the resources, you can access the .pbix 
�le (ADW-Part1-Theta) that shows completed steps after part A. This might be useful to 
reference your own dataset against if you need to, or if you want to jump to part B. 

In part A of the guide, you�ll use Power Query to connect, prepare and model data from 
multiple Excel �les.

In part B of the guide, you�ll use Power BI Desktop to:
� Visualise the data to get a clearer picture about the business based on the facts  
hidden in the data.
� Use Quick Measures to extend measures with time intelligence to provide 
meaningful insights. 
� Get custom visuals.

For terminology, refer to the Glossary in the appendix. 

       denotes an extra tip or trick you might want to know. 

       shows where there are instructions to follow. 
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In this section, we discuss Power BI Desktop, sample data and different phases in 
development.

Full instructions for downloading Power BI Desktop are available in our �rst guide. 
Once installed on your local computer, you will be able to connect to different sources, 
transform, and visualise your data. 

Note: Power BI occasionally updates its user interface, so screenshots in this guide may 
vary slightly to what you see on your screen.

Getting Started

1.1 Power BI Desktop

You will have received the sample �les alongside this guide. Although the �les are similar 
to the ones used in the Beginners Guide, there are some key differences. You must use 
these new �les for this Intermediate Guide. 

� Find the sample �les.
� Save the �le to your local computer and unzip the content into a folder

that can be accessed by Power BI Desktop.
� Browse to the saved data �les:  DimCustomerDimCustomer and AdventureWorks2017. You will 
also have ADW-Part1-Theta. 

1.2 Sample Data

Power BI is designed to be user friendly. Once you connect to a data source, you can 
shape and transform the data (remove columns, change data types, and so on), do data 
modelling (create relations) and visually present that data.
This guide steps you through the following phases:

� Connect to data sources.
� Shape the data.
� Model the data.
� Report on the data.

Now, let�s get started with the Power BI Desktop tool.

1.3 Power BI � Phases in Development

Note: If you see a popup window that says, �There are pending changes in your 
queries that have been applied. Do you want to apply them�, select yes.
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Part A
You�ll need these �les:

1. DimCustomer (.csv)
2. AdventureWorks 2017 (.xlsx)

Looking for further Power BI training for your team? 
Check out our training options. 

For other data and insights related training, try our 
Data Accelerate workshops. 
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Power BI can already connect to over 110 different data sources and connection types, 
with more being added. As well as connecting to Text/CSV �les - like we covered in the 
Beginners Guide - some are more complex.

Commonly used Power BI data sources include:

� File (Excel, Text/CSV, XML, JSON, PDF).

� Database (SQL Server, Oracle, IBM DB2, MySQL, PostgreSQL, Snow�ake, etc).

� Power Platform (Power BI datasets, Power BI Data�ows, Common Data Services) 

� Azure (SQL Database, Synapse Server, Analysis Services, Blob Storage, Data Lake, 
Cosmos DB, etc).

� Online Services (SharePoint, Dynamics 365, Dynamics Business Central, Azure 

DevOps, Salesforce, Google Analytics, Facebook, GitHub, etc).

� Other (Web, OData, ODBC, Hadoop, Spark, R script, Python script, etc).

The available data sources can be accessed via the Get data button in Power BI 

2.1 Data Sources

2. Connecting to Data Sources

Some data sources allow you to choose the Data Connectivity mode (i.e. connecting 
directly to data). There are four options available:

Data is imported into the Power BI dataset and cached in memory. When you submit 
report and dashboard queries to the dataset, it returns results from the imported data. 

You must refresh the dataset to get any changes that have occurred in the underlying 
data source. This has many advantages, including increased performance and the 
ability to work of�ine. 

We used this mode in the Beginners Guide when importing from CSV �les. We�ll use 
the import mode in this guide. 

2.2 Connection Modes

2.2.1 Import 
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Data is not imported into the Power BI dataset from the data source. Report and 
dashboard queries submitted to the dataset will result in new data being returned from 
the data source. In this mode, refreshing the dataset is not necessary. Not all data 
sources offer a DirectQuery option; for example, CSV �les are only available for import, 
so we will not discuss this mode in this guide.

Data sources have limitations when using DirectQuery. Details of these can be 
found on the Microsoft website here. 

2.2.2 DirectQuery 

Mixed mode refers to occasions where data is imported into Power BI, while some 
others are in DirectQuery mode. This mixed mode leans towards more advanced data 
modelling in Power BI, so won�t be covered in this guide.

Connect Live is a speci�c type of connection which only supports SQL Server Analysis 
Services (SSAS) databases, either Multidimensional or Tabular models, and Power 
BI Datasets. In this mode, the data model is held by an instance of SQL Server 
Analysis Services or in a Power BI Dataset in Power BI Service. Currently, when we�re 
connecting live to an instance of SSAS or a Power BI Dataset, Power BI turns into a 
data visualisation tool only. Therefore, data transformation and data modelling are not 
currently available in this mode. We can create report level measures using DAX when 
connected live to a SSAS Tabular instance or a Power BI Dataset. Connect Live won�t 
be covered in this guide.

2.2.3 Mixed Mode 

2.2.4 Connect Live 
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Let�s get started with importing the data:Let�s get started with importing the data:

� Open Power BI Desktop as shown in Figure 1 below.

2.3 Importing Data

Figure 1: Opening Power BI Desktop from Windows Search

� When you launch Power BI Desktop, a welcome splash screen is displayed
� To connect to the sample data for this exercise, select Get data

Figure 2: Get data from Power BI Desktop splash screen
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� Alternatively, click the Get data button from the Home tab on the ribbon bar
 

Figure 4: Most common data sources shows by clicking the down arrow on the Get data button

Figure 3: Get data from the Home tab in Power BI Desktop

Selecting the down arrow on the Get data button shows the most common data sources 
menu.  Select More� to open the Get Data dialog.

� Select Text/CSV from the list and click Connect.

Figure 5: Getting sample CSV data
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Figure 6: List of the sample �les to be loaded into Power BI

� Browse to the unzipped data �les, select the �rst �le DimCustomer.csv,
and click Open.

Figure 7: Loading the data to be used

� When you click Open, the window shown in Figure 7 below appears,
displaying sample data from the selected �le.

� We have two options, Load or Transform Data. We want to transform our data,
so we click the Transform Data button.
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Figure 8: Power Query Editor

Clicking Load will import the tables exactly as is. This is how we imported the CSV �les in 
the Beginners Guide. It is still possible to transform the data later by clicking the Transform 
Data button from the Home tab in Power BI Desktop.

� Clicking Transform Data opens a separate window - the Power Query Editor:
a powerful data pro�ling and data preparation tool.

� Before we continue transforming data, we need to get the remaining data.
We can get additional data directly in the Power Query Editor by clicking New 	                 
Source.

Figure 9: Adding new data sources

� Select Excel under All or File and click Connect.

Figure 10: Getting data from Excel
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Figure 11: Selecting Excel work sheets

� To import the data, browse to the unzipped data and select AdventureWorks2017
.xlsx then click Open.

� A dialog window opens listing the data sources within the Excel �le.
Click the checkboxes next to each source and click OK.

We�re now connected to the data sources. It�s time to pro�le and transform our data 
before creating our data model.

Figure 12: The Power BI Desktop application interface

Let�s take a moment to explore the Power Query interface. 

3. Data Preparation with
Power Query

The Application Ribbson contains all options and settings. Complete the steps:

1.	 Click the View tab from the ribbon. Make sure the following are ticked:
2.	 Formula Bar
3.	 Column quality
4.	 Column distribution
Note: If show white space is ticked, you can leave as is.
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Figure 13: Enabling some layout and data preview items in Power Query Editor

As Figure 13 illustrates, the application ribbons contain all options and settings, 
transformations, and other settings con�gurations.

1. The left pane shows different Queries. These can be the tables you selected for 
import or custom functions, query parameters, or queries with constant values that
you create in Power Query.

2. The Column header shows the column name and data type (Number, Date, Text,
True/False etc).

3. The Column quality bar shows details on the number of valid, empty and error 
records in the data. 

4. The Column distribution bar provides counts of distinct and unique values. 
5. The Data displays the view of the data based on the data transformation step that 

has been selected.
6. The Data Transformation Steps shows a list of data transformations that have 

been applied to the data.
7. The Status bar shows the number of columns the selected query from the Queries 

pane have, number of rows and data preview refresh date and time.
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Power Query allows us to split a column into one or more other columns. There are 
various options available under the Split Column dropdown.

We will be using By Delimiter to split the Name into First and Last Name.

� Go to the Queries pane on the left and select DimCustomer.
� Select the Name column.
� From the ribbon bar, go to the Transform tab, click Split Column and select

By Delimiter.

3.1 Splitting Columns

Figure 14: Split column by delimiter

� In the dialog box, ensure Select or enter delimiter is set to Space.
� Select Each occurrence of the delimiter and click OK.

Figure 15: Selecting the delimiter
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Figure 16: Column �Name� split to two columns

� The Name column is split into Name.1 that has the First Name and Name.2 that has the
Last Name. The splitting column by delimiter action above creates a new applied step 
as shown in Figure 16 below:

We will rename the two columns created by the splitting of the Name column. There are 
a  couple of ways to do this: either double click the Header name or right-click the header 
and select rename.

� Double click the Name.1 Header and rename it to FirstName.
� Right click the Name.2 Header and rename it to LastName.

3.2 Renaming Columns

Figure 17: Renaming Columns
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Adding Columns is a common task and there are many ways to do this. There is a 
dedicated tab in the Ribbon bar for adding columns. In the next few steps, we use a 
Conditional Column and a Column from Example to add new columns.

In the steps below, we will add a new conditional column - TotalChildrenNumber.

1. Go to the Queries pane, select the DimCustomer query.
2. Go to the Ribbon bar, select Add Column, select Conditional Column.

3.3 Adding Columns

Figure 18: Adding a conditional column

3. In the dialog box, change column name from Custom to TotalChildrenNumber.
4. Modify the If statement to read: If TotalChildren equals one Then 1.
5. Click Add Clause.
6. Add the additional �if� clauses for the remaining values (the values in this

dataset goes up to �ve. Remember that one is the only value that needs to be in all
lowercase!). *

7. Enter 0 for Else, this will assign 0 to any remaining records including those
with the value �None�.

8. Click OK and our new column will be added.

*Important: Note that Power Query is CAsE sEnSiTive. In this dataset, you�ll need to write �one� in 
all lowercase. For Two, Three, Four and Five, the �rst letter will be uppercase. 

Remember to save your work as you go.

In the next steps, we�ll add an Annual Income column:

1. From the Queries pane, select the DimCustomer query.
2. Go to the Add Column tab, select the Column from Example dropdown
3. Select From Selection. This adds a new column called Column1 at the end

of the columns list.
4. Select the YearlyIncome column.



18| Power BI for Intermediates

5. In the �rst row in Column1, type in the same number as is shown on the �rst row
of YearlyIncome. (Unless the table has been sorted differently, you should type in
90000, note you don�t need to type USD just the numbers.).

6. Press Enter and all the rows will be updated. You may need to enter more rows for
the rest of the column to populate. 

7. Rename Column1 to AnnualIncome (double click the column title to rename, note
that in some versions of PowerBI your column maybe be renamed �YearlyIncome-
Copy�).

8. Click OK

Figure 19: Adding column from example

We can remove columns that we no longer need e.g. duplicate columns. This also 
applies to columns that are used to add new columns such as the TotalChildren and 
YearlyIncome.

You can remove a column that has previously been used to create a new column. It does 
not impact on the data in the new column.  

� Select the DimCustomer query from the Queries panel.
� Hold Ctrl and click the column headers for YearlyIncome, TotalChildren, 
SpanishEducation, FrenchEducation, SpanishOccupation and

FrenchOccupation.
� Right click in any of the selected column headers and click Remove Columns.

3.4 Removing Columns

Figure 20: Removing columns in Power Query Editor
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Figure 21: Changing column data types

Each column in Power BI has a data type. When connecting to a data source, Power 
Query loads 1,000 rows of data as sample data and automatically detects the data 
types. While in many cases the detected data types are correct, in some cases we may 
face data type conversion errors when the detected data type is incorrect. Therefore, it 
is advised to always review the data types before continuing with other transformation 
steps. For instance, storing a customer number as a number where it should probably be 
stored as a text �eld.

The most common data types and their column icon in Power BI are:

�       Text e.g. Bicycle
�       True/False
�       Whole Numbers e.g. 148
�       Decimal Numbers e.g. 3.5432
�       Fixed Decimal Number e.g. 5.45
�       Percentage e.g. 46.8%
�       Date e.g. 15/02/2020
�       Time e.g. 12:35:00 PM
�       Date/Time e.g. 15/02/2020 10:25:00 AM

In the steps below, you�ll make a correction in the automatically detected data types:

� Select the DimCustomer query from the Queries pane.
� Go to the TotalChildrenNumber column and click the data type icon.
� Select Whole Number from the context menu.
� The data type icon changes to the Whole Number icon.
� Click the data type icon next to the AnnualIncome column.
� Select Fixed Decimal Number. This is similar to currency.
� The data type icon changes to the Fixed Decimal Number icon.
� Click the data type icon next to the HouseOwnerFlag column.
� Select True/False.
� The data type icon changes to the True/False icon. The 0 values have been set to

False and 1 has been changed to True.

Figure 21 shows changing the data type of the TotalChildrenNumber.

3.5 Changing Data Types
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All transformations are applied as a series of steps shown in the Query Settings pane as 
shown in the Figure 22 below.

3.6 Transformation Steps

Figure 22: Transformation steps

Figure 23: Illustrating the resulting changes of each step in the data

It�s possible to see the resulting data of each step by clicking on a desired step from the 
Query Settings pane as shown in Figure 23 below. This makes it easy to visually inspect 
the data after applying each transformation step.

Transformations can be added, edited, removed, renamed, or reordered by right clicking 
a desired step from the Applied Steps selector in the Queries Settings as shown in 
Figure 24.
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Figure 24: Renaming, deleting, inserting new step and moving steps

Depending on the data source type, the following transformation steps may already exist 
for each query:

1. Source
The very �rst step of the query is normally connected to the data source. In this 
tutorial, the sources will be a Text/CSV source and the Excel Source containing the 
other tables.

2. Navigation
If the data source we are connecting to has different objects containing data, 
such as an Excel workbook that can contain many worksheets and/or tables, then 
by selecting each object from the source system we are navigating through that 
object to get the containing data. For each Query, this will be the corresponding 
worksheet or table name in the Excel File, while Text/CSV �les do not have a 
Navigation step as each �le contains only one set of data.

The existing steps can be renamed within the Power Query Editor. This shows what the 
step did and makes future modi�cation easier. It�s highly recommended to rename the 
steps to something more meaningful.

� Select the DimCustomer query in the Queries panel.
� Right click the Split Column by Delimiter step.
� Click Rename from the context menu and change to Split Name.
� Right click the Added Conditional Column step.
� Click Rename and change to Add Total Children Number.

3.6.1 Renaming an applied step 
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� Right click the Inserted Text After Delimeter step.
� Click Rename.
� Type Add Annual Income.

Figure 25 shows the renamed steps (and the rest of steps we left as is). We�ve left 
those steps for you to rename.

Figure 25: Renaming steps

Select the DimCustomer query in the Queries pane. The Applied Steps pane shows 
all steps in the order that they are applied:

1. Click Source to see what the original data looked like. You should see the single
Name column.

2. Click Split Name to see the changes made by this step. The Name.1 and
Name.2 columns should be visible.

3. Click Renamed Columns in the Applied Steps panel and you should see the
columns renamed to FirstName and LastName.

3.6.2 Viewing transformation step changes

Figure 26: Viewing how transformation steps change the data
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The steps added earlier to remove columns and change types resulted in new 
steps being added to the end of the applied steps. The results of the last step 
contain the data that will be imported into the data model and available for 
visualisation. You can add a step in between existing steps. Let�s add a step that 
renames TotalChildrenNumber to TotalChildren, but we�ll add it after the existing 
TotalChildren column has been removed.

1. Select the DimCustomer query in the Queries pane.
2. Go to the Applied Steps pane and click Removed Columns. 
3. Right click TotalChildrenNumber
4. Select Rename
5. Type TotalChildren and press enter
6. A popup will ask if you are sure you want to insert the step. Click Insert.

3.6.3 Adding a step between an applied step 

Figure 27: Inserting a step between existing steps in the Power Query Editor

6

5

4
2

31
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You should see a step called Renamed Columns2 is added between Removed 
Columns and Changed Type2. Don�t worry if you see an error, we are about to �x that!

Figure 28: A new step is added between existing steps

Figure 29: Moving existing steps up or down

You can change the order of the steps by dragging and dropping a step to another 
location. 

Be careful when reordering steps as it may have a negative impact on future steps that 
depend on the moved step. 

� Select the DimCustomer query in the Queries panel.
� Click and drag Add Annual Income and drop it above Add Total Children

Number. This step will now take place before the Add Total Children
Number step.

3.6.4 Reordering applied steps
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Figure 30: Opening �Advanced Editor�

Figure 31: Enabling Formula bar from the Power Query Editor

All existing steps can be modi�ed. If there�s a settings icon     to the right of the 
name, you can edit the step from the UI. Otherwise, you can modify the existing 
steps from the code - either by opening the �Advanced Editor� or from the �Formula 
bar� (if enabled). Before we look at editing existing steps, let�s see how we open the 
�Advanced Editor� and how we can enable the �Formula bar�.

� You can access the �Advanced Editor� from various places. You can right click
a query then click �Advanced Editor�. You can alternatively click the �Advanced
Editor� button from the �Home� tab.

3.6.5 Editing an existing step

� Enabling Formula bar is easy. It�s bene�cial as it can help you to understand
and learn how Power Query works. Clicking each step allows you to see and 
modify the Power Query expressions.

So, for those columns that cannot be edited, using the Formula bar is handy. To 
enable the Formula bar, click the corresponding tick box from the
View tab as shown in the Figure 31:
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Note: In section 3.6.4, we renamed the TotalChildrenNumber column to TotalChildren. This 
breaks the Changed Type2 step. You�ll see an error message  on the Queries Panel to the 
left. To �x this error, we have to: 

� Click the Changed Type2 step.
� From the formula bar, replace the words TotalChildrenNumber with TotalChildren.
� Click the Commit button as shown in Figure 32, in some versions of PowerBI this

may happen automatically.

Figure 32: Edit steps from the UI (when applicable)

All steps can be deleted except the source steps. You can either delete just the 
selected step or all steps from that one until the end. 

Be careful when deleting steps. It may have a negative impact on future steps 
that depend on the deleted step. Power BI will give you a warning when you 
attempt to delete any steps.

In this instance, you don�t need to delete any steps. 

3.6.6 Deleting an applied step

Figure 33: Deleting the steps
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In this chapter, you learnt some data preparation steps like splitting columns, renaming 
columns, adding new columns, changing data types and so on. Once you�ve completed 
the required transformation steps, you can load the data into the data model. In the next 
chapter, we look at the basics of data modelling.

Data modelling is one of the most important aspects of data analysis, regardless of 
the tools we use, and Power BI is not an exception. After we import data into the data 
model, we need to create and manage relationships, creating analytical calculations and 
implement the business logics available for data visualisation. Here are the basics of data 
modelling.

4. Modelling the Data

Relationships between tables are necessary to accurately calculate the results and 
visualise the correct information in the report. When we create a relationship between two 
tables, we are creating a linkage between the data stored in those tables in one of the 
following ways. Let�s imagine we have two tables, Table X and Table Y:

� A row of data from Table X is related to one and only one row of Table Y. This type
of relationship is called a One-to-one relationship. Like when we stored the
personal details of a customer in a table called Customer and we stored the
customers� address in a table called Address and a customer has only one
address.

� A row of data from Table X is related to many rows from Table Y. This type of
relationship is called a One-to-many relationship. In our previous example, a
customer can have many sales orders, so if we stored the sales orders in a Sales
table, then each customer from the Customer table relates to many rows of sales
data from the Sales table.

� A row or data from Table X is related to many rows of data from Table Y AND a
row of data from Table Y is related to many rows of data from Table X. This type of
relationship is called a Many-to-many relationship.

Now that you know about the different types of relationships in Power BI, let�s see how to 
identify the columns contributing to a relationship. 

4.1 Relationships in Data Modelling

To be able to create a relationship, we �rstly need to identify the key columns in both 
related tables. There are two types of key columns, Primary Key and Foreign Key.

4.1.1 Identifying Key Columns in Power Query
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In data modelling, we refer to tables as Entities. A table consist of columns holding 
the data. Each column describes an Attribute of an Entity.

The columns (attributes) hold the data that describe Records of columns 
(attributes).

Each record of data in a table (entity) is a row.

For instance, in a Product table (entity), the columns (attributes) of the table 
contain the product data. Each row (record) of data describes a single product. 

In data modelling, we normally have a column or a combination of columns who can 
describe a unique row, hence we do not need to mention all columns to describe a 
single unique row (record) of data. The column or columns that describe a unique 
row are so called Primary Key columns. The primary keys consist of combination of 
columns are so called Composite Keys. 

In Power BI, Composite Keys are NOT supported, therefore we must have one 
primary key column only. It is NOT mandatory for all tables to have a primary key 
column. At this stage you may ask �well, how can we identify the primary keys 
then?�. The answer is that it depends. In many cases, the tables in the source 
system already contain a column that has a Key or ID in the column name, 
especially if the source system is a relational database like SQL Server, Oracle etc. 
But there are still many other cases that you do not have that option, therefore, you 
may need to �nd the primary key columns yourself. Let�s have a look at an example 
and �nd the primary key of the Customer table from the sample �le provided with 
this guide. 

Follow the steps below:

� If you previously closed the Power Query Editor and you are back to the
Power BI Desktop window, go to the Home tab and select the Transform data
button to open the Power Query Editor. Otherwise jump to the next step.

� Go to the View tab and make sure that Column Distribution is ticked.
This will show a new box on top of each column below the column title.
This box is called Column Distribution Box.

� Look at the Column Distribution Box to �nd a column that has the most
unique and distinct values. Hover-over each column�s distribution box and
look at the Distinct % and Unique % values in Figure 34 below:

4.1.1.1 Primary Key
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As you see in Figure 34, there are currently two columns that can be primary keys 
for the DimCustomer table. In cases like this, we need to have a good level of 
understanding of the business to be able to pick one of those columns as the 
primary key column. In this case, we already know that the CustomerKey column 
is indeed the primary key of the DimCustomer table. Therefore, we will use the 
CustomerKey column when we want to create a relationship between this table and 
other tables in the data model.

Important Notes: 

� The method mentioned above is just to identify the Primary Key column of the
tables.

� The Column Distribution information is based on top 1,000 rows of sample of
data as shown in the status bar in the Power Query Editor window in Figure
35. If we have more than 1,000 rows of data in the underlying table,
which in our example we do, the Column Distribution information is not very
accurate. 

� To make the Column Distribution information more accurate, we have to
change the column pro�ling data to be calculated based on the entire dataset
as shown in Figure 35. Select this by clicking on the footer.

Figure 35: Changing column pro�ling sampling data

Figure 34: Identifying Primary Key using Column Distribution feature in Power Query
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So far you learned what Primary Keys are. When we have a Primary Key of a table 
in another table, then that column is called Foreign Key. It is NOT necessary that 
the foreign keys contain unique values. 

You�ve now �nished using Power Query. You need to save the data that you have 
worked on.

� Save what you have done in Power Query. Go to �le and save as �ADW-Part1�
� Apply all changes
� Exit out of Power BI

When we resume in part 2, you will need to use the new �le that you have saved 
�ADW-Part1�.

If you�re jumping straight into part 2 of the guide, or you were unable to complete 
part 1, you should use the supplied �le �ADW-Part1-Theta�. This should match the 
one that you�ve just created (providing all the steps in this guide were completed 
successfully). 

4.1.1.2 Foreign Key

Introduction
- Part B

In Part B of the guide, we jump back into Power BI Desktop. 

Some notes before we get started:

�	 You�ll see that we�ve highlighted expressions in grey boxes. You can copy/paste 
these, but we�d recommend retrieving them from GitHub as it preserves the correct 
formatting. Access the expressions in GitHub here. 

�	 If you�re copy/pasting expressions, you must ensure that the code copies straight 
speech marks " as opposed to curly speech marks �. Curly speech marks in the code 
will not work!

�	 Part B explains more concepts around Power BI. To make it easier to follow, you 		
can jump to the yellow highlighted sections; these show the instructional steps to take. 

�	 Part B uses the dataset from where you �nished in part A. If you need to access the 
completed dataset from Part A (e.g. if you�re starting from Part B or you had issues 
completing part A), use the supplied �le ADW-Part1-Theta.  
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Part B
You�ll need:

1. Saved dataset from part A (ADW-Part 1)
    OR Theta�s supplied .pbix �le (ADW-Part1-Theta) 
2. Access to the GitHub repository

How are you getting on? If you need a bit more ‘hands-on’ help, try our 
Power BI team training. 

For other data and insights related training, take a look at our
Data Accelerate workshops. 
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5. Understanding relationships
in Power BI
We always create relationships between the Primary Key of a table and its 
corresponding Foreign Key in another table. Let�s look at our imaginary tables - Product 
and Sales - to get a better understanding of the relationships.

Figure 36: The structure of Product and Sales tables

In Figure 36 above, the ProductKey column is the Primary Key of the Product table and 
a Foreign Key in the Sales table.

We create a relationship between Product and Sales using the ProductKey column 
in both tables. As you can see in Figure 36, every single value of ProductKey from 
the Product table has many corresponding values in the Sales table; the relationship 
between the two tables is a One-to-many relationship. Creating a relationship between 
the two tables will look like Figure 2: the (1) resembles the One side of the relationship 
and the (*) resembles the Many side of that relationship.

Figure 37: One-to-many relationship between Product and Sales tables

Let�s add another set of tables to our existing set of imaginary tables, Customer and 
Customer Address:
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Figure 38: The structure of Customer and Customer Address tables

Figure 39: One-to-one relationship between Customer and Customer Address tables

Figure 40: Creating one-to-many relationship between Sales and Customer

As Figure 39 illustrates, each customer from the Customer table has one and only one 
corresponding address in the Customer Address table. Therefore, the relationship 
between the two tables is a One-to-one relationship.

Power BI is not only a reporting tool. It�s an analytical tool that you can create data 
models with. The data model in Power BI includes tables and their relationships. 
There�s a speci�c tab in Power BI called the Model View - placed in the left pane of the 
Power BI Desktop as shown in Figure 41.

5.1 Creating Relationships in Power BI

Figure 41: The Model view tab in the laft pane in Power BI Desktop
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Figure 42: Power BI automatically detected some relationships

So far, you�ve learnt about Primary Keys, Foreign Keys and relationships. Power BI can 
also create the relationships between tables. However, it sometimes detects incorrect 
relationships; we must review the automatically generated relationships from the Model 
view.  Follow these steps:

� Go to Power BI Desktop. 
� Go to �le, open report and select the �le that you saved at the end of part 1 of the

guide. �ADW-Part1.pbix� (or access our supplied �le ADW-Part1-Theta).
� Go to the Model view. Some relationships have been automatically created    

between a few tables. Note that your data model may be arranged differently. 

Figure 43: The direction of �ltering from DimCustomer to FactInternetSales

The arrows on the relationships indicate which direction �ltering will occur. In Figure 43, 
if we put a �lter on a value of a column from the DimCustomer, the FactInternetSales will 
only show records related to the selected value.
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Figure 42 showed that not all relationships have been automatically detected by 
Power BI; we�ll need to create the rest of them manually. Follow the steps:

1.	 Click the Manage Relationships button either from:
A. The Modelling tab from ribbon bar
B. Or the Model view tab from the left pane
C. Or the Data view tab from the left pane under the Table tools tab from the

ribbon bar (Figure 44).

Figure 44: Accessing the Manage Relationships button in Power BI Desktop

2. Select the New… button from the Manage relationships window.
3. Select DimProduct from the �rst dropdown box.
4. Highlight the column ProductSubCategoryKey. 
5. Select DimProductSubCategory table from the second dropdown box.
6. Highlight the column ProductSubCategoryKey.
7. Ensure the cardinality is set to Many to One (*:1).
8. Leave the Cross �lter direction to Single.
9. Make sure the Make this relationship active is ticked.
10. Click OK, then close the window.

Figure 45 shows these steps. 
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Figure 45: Adding a new relationship

We�ll create the �nal relationship in an alternative way. Follow this step:

1. Drag the OrderDateKey from the FactInternetSales table and drop it over the 
DateKey Column of the DimDate table. 

Figure 46: Creating relationship from the Model view by dragging and dropping a key column

After creating all relationships, your model should look like Figure 47.

Figure 47: The Model view after creating relationships



37| Power BI for Intermediates

A data model consists of Tables and their Relationships. There are also other elements 
included in the data modelling:

1. Calculated Tables
2. Calculated Columns
3. Measures

All these can be created programmatically using DAX. In the next few sections, we look 
at them in more detail.

5.2 Creating Calculated Columns and Measures
with DAX

5.2.1 Calculated Tables

On some occasions, you need to add new tables based on data you�ve already loaded 
into the model. These tables can be created using DAX. 

You can also use table constructor in DAX to create a calculated table. Table 
constructor isn�t a function; it�s a set of characters that allow you to create a table in 
DAX.  For example, the following DAX expression creates a table with one column 
(Figure 13).

Calculated Table 1 = 
    {�A�, �B�, �C�}

Figure 48: Creating a calculated table with one column using table constructor
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You can use curly brackets {} to construct a table. This is a simple form of using table 
constructor in DAX. Here�s how it works:

� Start of table construct - open curly bracket {
� �A�, �B� and �C� are the values of a single column
� End of table construct - close curly bracket }

You can use any scalar DAX expressions in the values. The example below creates 
another calculated table using the table constructor and the DATE() function:

Calculated Table 2 = 
    {DATE(2020, 7, 22), DATE(2020, 7, 23), DATE(2020, 8, 2)}

Figure 49 shows the results of running the above DAX expression (you don�t need to 
complete this as a step).

Figure 49: Creating calculated table with DAX table constructor using DATE() function

The following DAX expression is another structure of table constructor: when you 
de�ne rows of data records using parentheses () where the values are separated with 
comma. As you see in Figure 50, you can use constant values or scalar expressions to 
de�ne the rows.

Calculated Table 3 = 
{
        ( �A�, 1.5, DATE(2017, 1, 1), CURRENCY(199.99) ), 
        ( �B�, 2.5, DATE(2017, 1, 2), CURRENCY(249.99) ), 
        ( �C�, 3.5, DATE(2017, 1, 3), CURRENCY(299.99) ) 
     }

Figure 50 shows the results of running the above expression in Power BI:
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As above, when de�ning the rows in the table constructor, the default column names 
are speci�ed as Value1, Value2, Value3,�

We previously stated that we can also use any DAX functions that result in a table 
value. There are many use cases for that. For example, if you want to create a 
calculated table to show:

� The customers� full name - which is the concatenation of their �rst name
and last name.

� Their total sales.
� Where the country region is Australia.

To create a calculated table, click the New table button from the Modelling tab from 
the ribbon (You need to have the data view tab highlighted in the leftpane). Then use 
the following DAX expression in the expression box. These steps shown in Figure 52:

Figure 50: Creating a calculated table with DAX constructors using constant values or scalar expressions

Australian Customers Sales = 
SUMMARIZECOLUMNS (
    DimCustomer[CustomerKey]
    , FILTER(
        VALUES(DimGeography[EnglishCountryRegionName])
            , DimGeography[EnglishCountryRegionName] = �Australia�)
    , �Customer Full Name�, CONCATENATEX(DimCustomer, DimCustomer[FirstName] & � � & 
DimCustomer[LastName])
    , �Sales Amount�, SUM(FactInternetSales[SalesAmount])
)

Figure 52 shows the results of running the preceding expression.
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Figure 51: Creating a calculated table to show sales for Australian customers

In Figure 51, the table has only 3,591 rows while the original DimCustomer table has 
more than 18,000 rows.

Figure 52: The results of running the preceding DAX expression

5.2.2 Calculated Columns

Calculated columns are the new columns created in the data model using DAX. There 
are many scenarios when you want to create a calculated column; the general rule of 
thumb is that you only create a new calculated column if:

� There�s a complex scenario and you want to create calculated columns to
use them in other calculations like measures.

� You need to create a new calculated column to be used in a slicer or as a �lter
on a report element.

Other than that, you should avoid creating new calculated columns as there�s risk of 
performance degradation.
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Figure 53: Create a Calculated Column

You can create a calculated column either from the Report view or the Data view (you 
don�t need to complete this as a step):

A. Right click on a table from the Fields pane and select New Column.
B. Select a table from the Fields pane: select New Column from the Table

Tools tab.
C. Select a table from the Fields pane: select New Column from the

Modelling tab.

Figure 53 shows how to create a calculated column from the Report view. 

Let�s have a look at Calculated Columns in action. Follow the steps below:

1. Click the Data view tab from the left pane.

2. Go to the Fields column on the right, select DimCustomer.

3. Right click, go to New column. Type in the expression below.
4. Press enter.

Full Name = CONCATENATE(DimCustomer[FirstName] & � �, DimCustomer[LastName])
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Figure 54: Creating Full Name calculated column in the DimCustomer table

Note that there�s a space between the ��and�� in the DAX expression!

5.2.3 Measures

Measures are normally analytical calculations: summations, calculating averages, 
minimum, maximum, counts and so on. You can use the measures for visuals in Power 
BI. 

The result of the measures change depending on how we interact with them in different 
visuals. For instance, you create a measure to calculate Sales Amount. If you put the 
Sales Amount on a Card visual, it shows total sales amount over the whole data. If 
you use the same measure in a Column Chart with Product Category on the Axis, the 
measure always calculates the correct results for each category (Figure 55).

Figure 55: The result changes depending on visual interactions

You can create measures in various ways, just like the way you create calculated 
columns - either from the Report view or from the Data view (you don�t need to follow 
these as steps).
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Figure 56: Creating a new measure in Power BI Desktop

A. Right click on a table from the Fields pane and select New measure.
B. Select a table from the Fields pane and select New measure from the Table

Tools tab.
C. Select a table from the Fields pane and select New measure from the

Modelling tab.

 Follow these steps below:

1. Click the Report view on the left pane.
2. Right click the FactInternetSales table in the Fields pane.
3. Click New Measure.
4. Use the DAX expression below. This creates a Sales Amount measure in the

FactInternetSales table.

Sales Amount = SUM(FactInternetSales[SalesAmount])

Figure 57: Creating Sales Amount measure in the FactInternetSales
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5. Click the Card visual         from the Visualizations pane on the reporting
canvas.
6. Tick the Sales Amount measure to display its value on the
Card visual.

Figure 58: Showing Sales Amount on a Card visual

7. Click on a white space outside of the Card visual to release the focus from the
Card visual.
8. Go to FactInternetSales and tick Sales Amount to add the measure to the
visual.
9. Click the Clustered Column Chart       visual from the Visualizations pane to
add on the report canvas.
10. Go to the Fields pane on the right.
11. Go to DimProductCategory and tick the ProductCategoryName column to    add it 
to the visual Axis.

Figure 59: Sales Amount by ProductCategoryName in a Clustered Column Chart




























































